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1. Scope 
 
This document is intended to detail a typical installation and configuration of a gateway from the Dialogic® 4000 
Media Gateway Series if used to interface between a PBX or the PSTN and the Microsoft® Office 
Communications Server (OCS) 2007 application. Note that the term “gateway” is used herein to generically refer 
to a gateway from the Dialogic 4000 Media Gateway Series. 
  
2. Configuration Details 
 
Listed below are the specific details of the gateway used during testing to construct the following documentation. 
 
2.1 Gateway 
 

Gateway Series Dialogic® 4000 Media Gateway Series  

Software Version(s) Dialogic® Diva® System Release software version 8.3.2 build 459 
(formerly called Diva® Server software) 

Dialogic® Diva® SIPcontrol™ Software version 1.6 build 46 
(DSSIPControl.msi) 

Protocol T1 (NI2, QSIG, 5ESS) or E1 (QSIG, EuroISDN) 

 
2.2 System Diagram 
 
The diagram below details the setup used in the testing and creation of this technical document. In the diagram, 
the abbreviation “DMG4000” denotes a gateway from the Dialogic® 4000 Media Gateway Series. The term 
“OCS” stands for Microsoft® Office Communications Server (OCS) 2007 both in the diagram and throughout the 
document. 
 

PBX DMG4000

T1/E1

IP LAN

OCS Server

OCS Clients
5100         5101

TDM Stations
2410         2401
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3. Prerequisites 
 
3.1 PBX Cabling Requirements 
 
Cabling for PRI connections must be CAT5e or better. A standard voice quality cable will not provide the 
appropriate signal quality and will cause the gateway to have issues establishing a connection on the D-channel. 
If connecting the gateway directly to the PBX, it may be necessary to use a T1 crossover cable (Pin 1 is 
connected to Pin 4 and Pin 2 is connected to Pin 5). The crossover cable is only necessary if the alarm light on 
the front of the gateway remains lit red after connecting the gateway to the PBX. 
 
4. Summary of Limitations 
 
No limitations noted. 
 
5. Gateway Setup Notes 
 
Steps for setting up the gateway: 
 

1. Add the gateway to Microsoft® Office Communications Server (OCS) 2007.  
2. Configure the Dialogic® Diva® Media Board drivers. 
3. Configure the Dialogic® Diva® SIPcontrol™ Software. 

 
5.1 Adding the Dialogic® 4000 Media Gateway Series to the Microsoft® Office Communications 

Server (OCS) 2007  
It is necessary to add the gateway into the Active Directory containing the OCS environment: 
 

1. Add the gateway to the OCS domain. 
2. Add the Microsoft® Mediation Server on the gateway to OCS as follows: 

• Open a command prompt on the gateway. 
• Change the directory to:  c:\program files\common files\microsoft communications server 2007 . 
• Execute: 

o lcscmd.exe /MedSrv /Action:Activate /Password:<Password-of-RTCComponentService-
Account> 

o It might be necessary to also add a username for the RTC component service account. To 
do this add a /User:<user name>. 

3. Open the OCS MMC on the gateway: 
• Start > Settings > Control Panel > Administrative Tools > Office 

Communications Server. 
• Request, retrieve, and import a certificate from a CA (Certificate Authority) and add it to the 

Microsoft® Mediation Server. Refer to the OCS documentation for more information.  
Note: This step needs to be done while you are directly logged onto the gateway. It cannot be done 
using the MMC of the OCS on another PC in the domain. 
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5.2 Dialogic® Diva® Media Board Configuration 
 
The Diva Media Boards are configured in the Dialogic® Diva® Configuration Manager. To open the Configuration 
Manager, click:  
 
Start > Programs > Dialogic Diva > Configuration Manager. 
 
Note: In some instances within the software and documentation, Diva Media Boards are referred to as “Diva 
Server adapters”. 
 
A screen similar to the one below will appear. 
 

 
 
Note: The number of TDM circuits varies depending on the Dialogic® 4000 Media Gateway model that is used. 
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For this setup:  
• Click the icon of one PRI line.  
• Set the property Switch Type to the ISDN protocol that your PBX or telco supports. Common choices 

are:  
 

NI2 USA/Canada, Nortel DMS 100 (National ISDN) 
5ESS USA/Canada, AT&T 5ESS (Custom ISDN) 
Q.SIG PBX, Q-SIG T1 
EuroISDN Europe/other countries, Euro-ISDN (ETSI-DSS 1) 
 

Note: If you select PBX, Q-SIG T1 as Switch Type, you need to select the PBX Type from the 
dropdown menu below. If your PBX is not listed in this dropdown menu, select Generic, which will use 
a standard Q.SIG suitable for most PBXs.  

 
• Configure the switch type of the other PRI lines as described above. 
• To activate the changes, click File > Activate.  
• Restart the computer if you are asked to do so. 
• To test the connection with the PBX or the PSTN, see the Dialogic® Diva® Line Test tool on page 30 for 

more information. 
 
 
5.3 Dialogic® Diva® SIPcontrol™ Software Gateway Application 
 
The Diva SIPcontrol software is configured via the web-based interface. To open the web interface, click Start 
> Dialogic Diva > SIPcontrol Configuration.  
 
On the main page, click the SIPControl link to display the different configuration menus.  
The PSTN Interface Configuration section should automatically include all ports detected in the system. 
 
Note: If you do not see any detected ports, you may need to add http://127.0.0.1 as a trusted site. From 
Microsoft® Internet Explorer®, click Tools > Internet Options > Security > Trusted Sites. Use 
http://127.0.0.1:10005 to get to the configuration. 
 
In order for the Diva SIPcontrol software to route calls, the proper routes must be created and configured. Each 
route consists of a source interface and a destination interface. PSTN controllers and SIP peers are considered 
either a source interface or a destination interface depending on the call direction. 
 
The following components need to be configured: 

• PSTN Interface  
• Network Interface 
• SIP Peer 
• Routing  
• Number Normalization (either an Address Map or a dialplan) 
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If you have a simple phone numbering scheme, all numbers are of the same number exchange (ex 973-967-
1xxx). It may be possible to use a dialplan to configure the gateway rather than an Address Map. In North 
America it is more common to need to use Address Maps. 
 
 
5.3.1  PSTN Interface 
 
The PSTN Interface Configuration shows the available T1 or E1 interfaces and enables you to configure 
them separately for Address Maps and dialplans. It is also possible to disable interfaces that are not in use. To 
disable the interfaces that are not in use, click the check mark in the Enabled field to delete it. 
 

 
 
 
5.3.2 Network Interface 
 
The Network Interface Configuration displays the network interface connections that are available for 
use by the Dialogic® Diva® SIPcontrol™ Software. You need to enable the IP address that the Diva SIPcontrol 
software should listen to. Since the Mediation Server is co-resident on the gateway enable the network interface 
connections of the main gateway. 
 
Since the Microsoft® Mediation Server and the Diva SIPcontrol software share the same network interface 
connections, it is necessary to configure them to listen and broadcast on different TCP ports. For the main 
gateway network interface connection, configure the TCP listen port to be an unused port like 9803. Enter this 
number in SIP Listen Port.  
 

 
Note: Take note of the SIP Listen Port number because you need it for the configuration of the Microsoft® 

Mediation Server. 
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5.3.3 SIP Peer 
 
Add a SIP peer to point to the Microsoft® Mediation Server. To do so, expand the SIP Peer Configuration 
menu and click Add. In the Edit SIP Peer Configuration window, configure the following: 
 

 
 

• Name: Enter a name for the SIP peer, e.g., Mediation Server 
• Peer type: Select MS OCS 2007 / Mediation Server from the dropdown menu. 
• Host: Set the IP address on which the Microsoft® Mediation Server is listening. On the gateway, it is the 

gateway’s IP address. 
• Port: Set the broadcast port that the Diva SIPcontrol software uses to communicate with the Microsoft® 

Mediation Server. It is the port on which the OCS Server listens.  
• IP protocol: Select TCP for the Microsoft® Mediation Server. 
• Click OK to save the settings. 

 
 
5.3.4 Routing Configuration 
 
In the Routing Configuration menu, you need to create two routes, one for the inbound direction (TDM to 
IP) and one for the outbound direction (IP to TDM). These routes together will connect a SIP peer and a PSTN 
interface. After the number normalization is configured you will need to return to these routes and add the 
Address Map or dialplan. To configure the routes, expand the Routing Configuration menu and click Add. 
In the Routing Configuration window, configure two routes; one for IP to TDM (outbound) and one for 
PSTN to IP (inbound). 
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For the IP to TDM (outbound) route, configure the following: 
 
• Name: Enter OCS to PSTN (outbound). 
• Direction: From the dropdown menu select SIP to PSTN. 
• Select sources: Enable the Microsoft® Mediation Server as source. 
• Select destinations: Select Controller1 as master destination. 
• Click OK to save the settings. 
 
Click Add to configure the PSTN to IP (inbound) route: 
 
• Name: Enter PSTN to OCS (outbound). 
• Direction: From the dropdown menu select PSTN to SIP. 
• Select sources: Select Controller1 as source. 
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• Select destinations: Select Enable the Microsoft® Mediation Server as master destination. 
• Click OK to save the settings. 
 
After both routes are configured, the Routing Configuration display should look like the picture below. 
 

 
 
 
5.4 Number Normalization 
 
There are two methods to do number normalization; via a dialplan or with the help of Address Maps. If your PBX 
dialplan is not very complex, or to just get started, a dialplan may be used. For most PBX using multiple DID 
ranges or fractured DID ranges, it is necessary to use Address Maps.  
Note: Do not enable both a dialplan and an Address Map at the same time. 
 

5.4.1 Dialplan 
 
A dialplan allows you to enter details about your numbering scheme specific to the location of the gateway to 
enable the Dialogic® Diva® SIPcontrol™ Software to either add digits to a number it receives from a PBX before 
being sent to OCS or remove numbers it gets from Microsoft® OCS so it can be sent to the PBX in a dialable 
format. Microsoft® OCS will always send an E.164 number to the gateway. With this number, the gateway needs 
to determine if it is an internal extension that should be dialed as a 4 digit number or an external number that 
needs to have a trunk access number appended to it prior to sending it to the PBX. The dialplan defines what 
the basic number formats look like to enable this conversion. In setting the dialplan, you define the different parts 
of a number, national prefix, area code, base number, and number of extension digits.  
 
Add a dialplan from Dialplan Configuration. Complete the settings and click OK. For the dialplan below, 
the following phone number characteristics are used:  
 
National Prefix: 1 
Area code: 716 
Base number: 639 
Extensions: 4 digits 
Access code: 9 
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• Enter the local Country code (1 for North America). 
• Enter the local Area code. 
• Enter the Base number of your DID phone numbers. This is the non-variable portion of your DID numbers.  
• Enter the number of extension digits. 
• Enter the prefix necessary to dial an international call. 
• Enter the prefix to dial a national call. 
• Enter the trunk access number to get an external line on the PBX if necessary. (9 for North America). 
• Click OK to save the settings. 
 
For a dialplan to be applied to outbound PSTN calls, click Details on the PSTN controller. 
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The following window opens: 
 

 
 
Configure the Address Normalization settings as follows:  
 
• Select the Dialplan you have just created. 
• Set the numbering format to Extension. 
• Set the encoding to Use Prefixes. 
• Set the Default numbering plan to unknown. 
• Click OK to save the settings. 
 
This configuration converts the dialed numbers from OCS into the format based on the dialplan so the PBX will 
be able to dial the number.  
 
For a dialplan to be applied to inbound SIP calls, click Details on the SIP Peer. 
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The following window opens:  
 

 
 
Configure the Address Normalization as follows:  
 
• Dialplan: Select the dialplan, you configured in Dialplan on page 10. 
• Number format (outbound): From the dropdown menu, select International number. 
• Encoding (outbound): From the dropdown menu, select Use type flag. 
• Click OK to save the settings and to close the window.  
• Click Save on the main page for the changes to take effect. 
 
This configuration converts the phone numbers into the E.164 format needed by OCS.  
 
 
5.4.2 Address Map 
 
The Address Map entry uses regular expression (as does OCS) for converting the call address format for 
inbound or (and) outbound direction. 
 
Note: Call address for outbound calls (IP to TDM) includes “@hostname” part. For example, 
+17166391234@DMG4000.bufocs.local is the call address, not just +17166391234. For inbound calls (TDM to 
IP), call address is the called or calling number with the possible addition of the prefix +, N or S. For example, an 
inbound call has called number 1234 with ISDN type of numbering flag set to Subscriber, and calling number 
49715233334444 with ISDN type of numbering flag set to International. The called address will be S1234 and 
calling address will be +49715233334444. If ISDN type of numbering flag is set to National, prefix N will be used 
with the call number. If type is Unknown, no prefix is used. This is important to know before applying RegEx 
rules in Address Map. 
 

5.4.2.1 Outbound calls (VoIP to TDM): 
 
OCS sends the E.164 dial number format to the gateway. Both called and calling numbers need to be converted 
to a format that the PBX can accept. Using the same PBX dialplan as in the previous section, the following 
conversions are needed: 
• In the “non-DID internal” rule, the gateway will automatically extract the number string following the “ext” field 

of the Invite and pass it to the routing table. Because of this mechanism it is only necessary to pass the 
extension in the CPID manipulation.  

• The “Internal” rule will extract the last 4 numbers from the right side to create a 4-digit extension to be dialed 
on the local PBX. 

• The “National” rule adds the trunk access number to the 11 digits following the “+”. Depending on your 
configuration, this can be changed or deleted. 
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• The “International” rule adds the trunk access number (in our case 9) and the international access number 
(e.g., 011). If necessary, you can change or delete the trunk access number. 

 
Calling number From OCS To PBX 
Internal  +1716639xxxx 716639xxxx 
 
 
Called number From OCS To PBX 
4-digit extention from 

non-DID number 
+17166391000;ext=xxxx xxxx 

To Internal  +1716639xxxx xxxx 
To National  +1xxxxxxxxxx 91xxxxxxxxxx 
To International  +xxx…xxx 9011xxx…xxx 
 
Below are the regular expression for the conversion tables above: 
 
Sub rule name Expression Format Stop on match 
Calling number ^\+1(716639\d{4}) $1 Not checked 
Called - non-DID ^\+17166391000\;ext\=(\d{4}) $1 Check 
Called - Internal ^\+1716639(\d{4}) $1 Check 
Called - National ^\+1 91 Check 
Called - International ^\+ 9011 Check 
 
 
The graphic below shows the Address Map entries for outbound calls. 
 

 
 
The order of the above 5 sub rules and the Stop on Match check mark are important. 
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Below is the first sub rule, Calling Number, that converts a E.164 calling number into 10-digit national number. 
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The following sub rule, Called – Non-DID, extracts the 4-digit extension following the E.164 “ext=” field. 
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Following is the third sub rule, Called – Internal, that converts E.164 for internal called number into 4-digit 
extension. 
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The following sub rule, Called – National, is for converting an E.164 national number into 10-digits national 
number with prefix 91. 
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The below rule converts an international called number by prefixing 9011.  
 

 
 
 
 

5.4.2.2 Inbound Calls (PSTN to VoIP): 
 

These examples assume that the PBX sends the inbound calls using 4-digit extensions. The rules will 
need to be modified if your PBX is sending different number of extensions. 
• Converting the called party number to E.164 format. 

It is not necessary to convert the called party number to E.164 before it is sent to OCS, as the 
existing normalization rules in OCS will take the number the gateway is receiving from the PBX, and 
normalize it to the correct format.  

• Converting the calling party number to E.164 format. 
If you want OCS to be able to do a reverse look up in the global address list (GAL) or in the users 
contact list, it is necessary to have the gateway convert the calling party number to E.164 to match 
the format in the GAL. This manipulation of the calling party information depends on the information 
that the gateway receives from the PSTN or PBX.  

• Removing the ISDN number type indicator. 
Dialogic® Diva® SIPcontrol™ Software appends the ISDN call type (N = National, + = International 
and S = Station) at the beginning of calling, called, and redirect numbers. Therefore, it is necessary 
to have a rule to remove these, as OCS does not make use of them. Here are a few examples of 
necessary conversions and the rules to achieve the needed conversions. 
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Called number From PBX To OCS 
All types [N,S,+]xxxx  xxxx 
 
Calling number From PBX To OCS 
Calling from internal xxxx +1716639xxxx 
Calling from national xxxxxxxxxx  +1xxxxxxxxxx 
Calling from international xxx…xxx  +xxx…xxx 
 
Sub rule name Expression  Format Stop on match 
Remove ISDN type 
   Called 
   Calling 
   Redirect 

^[NS\+]?  Not checked 

Calling - internal ^(\d{4})$ +1716639$1 Checked 
Calling - national  ^(\d{10})$ +1$1 Checked 
Calling - international (.*) +$1 Checked 
 
 
Create an Address Map named Inbound (TDM to VoIP) and its 4 sub rules as shown below. 
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The rule below removes Dialogic® Diva® SIPcontrol™ Software’s marking for the ISDN number type for the 
called number, calling number, and the redirect number if there is one. If OCS does not make use of it, it is 
removed. 
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The second rule converts a 4-digit calling number into an E.164 format to enable OCS to perform a reverse look-
up on the calling party. 
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Like the previous rule, this rule also converts the calling party to E.164 format; but this is looking for a 10-digit 
external number. 
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This final inbound rule converts the calling ID for an international caller into E.164 format. 
 

 
 
 
5.5 Applying an Address Map to a Route 
 
After you created the inbound and outbound Address Maps, it is necessary to link them to the inbound and 
outbound routes. To do so, expand the Routing Configuration dialog and in the dropdown menu under 
Address Map select Outbound (VoIP to TDM) for the outbound route and Inbound (TDM to VoIP) for 
the inbound route as shown in the graphic below. 
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5.6 Saving the Settings 
 
After you made the changes, you need to save the configuration. To save the configuration, scroll down to the 
bottom of the main page and click Save.  
 

 
 
5.7  Restarting the Dialogic® Diva® SIPcontrol™ Software 
 
Note: A restart of the Diva SIPcontrol software service is needed only if the settings under Network 
Interface were changed.  
 
Save the configuration and restart the Diva SIPcontrol software service for the changes to take effect. To do so, 
click Service Status on the left hand side of the main configuration page, and then click Restart 
SIPcontrol. The Last operation log will show that the service has been stopped and started again. 
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6 Microsoft® Mediation Server Configuration 
 
From OCS MMC snap-in, right click on the detected Microsoft® Mediation Server and select Properties. 
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The following window opens: 
 

 
 
On the General tab, configure the following settings: 
 
• Under Communications Server listening IP address and Gateway listening IP address, 

enter the IP address of the gateway. Since the gateway and Microsoft® Mediation Server are running on the 
same PC, the one address may be used for both gateway listening and OCS listening address.  

• Under Default location profile, enter the location profile that corresponds to the deployment location of the 
gateway. This is used for defining the normalization rules for the called party numbers. 
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On the Next Hop Connections tab, configure the following settings: 
 

 
 
• Next to IP address, enter the IP address of the gateway. 
• Next to Port, enter the same port number as in the Dialogic® Diva® SIPcontrol™ Software configuration. 

See section 5.3.2 Network Interface for more information.  
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On the Certificate tab, configure the following: 
 

 
 
Select the certificate that will be used to communicate with OCS. You need to restart Microsoft® Mediation 
Server for the changes to take effect. 
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7 Troubleshooting 
 

7.1 Important Debugging Tools 
 

• Dialogic® Diva® Line Test tool 
• Dialogic® Diva® Diagnostics tool: Used to review and analyze all SIP and ISDN traffic that relates to calls 

going into and leaving the gateway 
 

7.2 Dialogic® Diva® Line Test tool 
 
Diva Line Test tool enables you to test the PSTN configuration and connection. With this tool, you may place 
calls to the PBX or PSTN as well as receive calls for the PSTN or PBX without having other components set up 
on the IP side of the gateway.  
 
To start Diva Line Test tool, click: Start > Programs > Dialogic Diva > Line Test. 
Select the Phone/Loop tab to test the T1 or E1 connection. 
 

 
 
To test an outgoing call, do the following: 
• In Called Party Number, enter a PBX extension. If you want to place an external call, enter an external 

phone number. 
• Click Call to initiate the outbound call. 
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To test an incoming call, do the following: 
• Select Enable incoming calls […] box so that the Diva Line Test tool application answers a call from 

the PBX or PSTN. 
• Click Call to initiate the outbound call. 

 
Note: For incomming calls, the called, calling, and redirecting number information is presented if available. 
 
Note: For the Diva Line Test tool to answer an incoming call it is necessary to stop the Dialogic® Diva® 
SIPcontrol™ Software process. See Restarting the Dialogic® Diva® SIPcontrol™ Software on page 25 for how 
to stop the service. 
 
 

 

7.3 Dialogic® Diva® Diagnostics tool 
 

Before using the Dialogic® Diva® Diagnostics tool, you would need to enable it by setting the Dialogic® Diva® 
SIPcontrol™ Software debug. To do so, open the Diva SIPcontrol software web interface, click the link System 
Settings, and set Debug Level to Extended. Click Save for the changes to take effect. 
 
Now, you can start the Diva Diagnostics tool. To do so, click:  
Start > Programs > Dialogic Diva > Diagnostics. 
 

 
 

1. Click one line of your Dialogic® Diva® Media Board in the left pane and click  on the toolbar to activate 
the Basic tracing level. This level captures Q.931 ISDN messages.  
 

2. Click CAPI driver in the left pane and activate the Basic tracing level as explained in step 1. 
 

3. Start tracing. To do so, click the start icon  or select the Start Tracing option form the Tracing 
menu. 
 

4. Reproduce the issue. 
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5. To stop tracing, click the stop icon  on the tool bar or select the Stop Tracing option form the 
Tracing menu. 

 

6. To view your collected trace, click the view icon  on the toolbar or select the View Recorded 
Trace option from the View menu. A notepad window will open with the recorded log. 

 
 
Examples of Dialogic® Diva® Diagnostics traces for an inbound (TDM to IP) call to OCS 
 
Basic notations for reading the trace: 
 
• SIG-R: RX Q.931 ISDN message 
• SIG-X: TX Q.931 ISDN message 
• SIPR: RX SIP message 
• SIPX: TX SIP message 
 
< Below is RX Q.931 ISDN message for an inbound call > 
 
… 
9:16:28.431 C  3 21:2389:383 - SIG-R(030) 08 02 00 17 05 04 03 80 90 A2 18 03 A9 83 81 6C 06 01 A0 33 
30 30 32 70 05 C1 35 31 30 31 
                     Q.931  CR0017 SETUP 
                            Bearer Capability 80 90 a2 
                            Channel Id a9 83 81 
                            Calling Party Number 01 a0 '2401' 
                            Called Party Number c1 '5101' 
 
… 

<Below is TX SIP message with SDP> 
 
9:16:28.431 1 L 12 00010000-SIPX begin to IP:192.168.0.106 port:5060 socket:3 Proto:TCP 
 9:16:28.431 1 L 12 00010000-    >INVITE sip:+17166395101@dmg4000.bufocs.local:5060 SIP/2.0 
 9:16:28.431 1 L 12 00010000-    >Via: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.431 1 L 12 00010000-    >Max-Forwards: 70 
 9:16:28.431 1 L 12 00010000-    >Allow: INVITE,ACK,CANCEL,BYE,OPTIONS,NOTIFY,REFER 
 9:16:28.431 1 L 12 00010000-    >Accept: application/sdp,application/simple-message-summary 
 9:16:28.431 1 L 12 00010000-    >Supported: timer,replaces 
 9:16:28.431 1 L 12 00010000-    >From: "Dialogic Diva SIPcontrol" 
<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.431 1 L 12 00010000-    >To: "Default" <sip:+17166395101@bufocs.local;user=phone> 
 9:16:28.431 1 L 12 00010000-    >Call-ID: 9c046698-730448-17@dmg4000 
 9:16:28.431 1 L 12 00010000-    >CSeq: 1 INVITE 
 9:16:28.431 1 L 12 00010000-    >Min-SE: 90 
 9:16:28.431 1 L 12 00010000-    >Session-Expires: 600;refresher=uac 
 9:16:28.431 1 L 12 00010000-    >Contact: <sip:+17166392401@192.168.0.106:9803> 
 9:16:28.431 1 L 12 00010000-    >Content-Type: application/sdp 
 9:16:28.431 1 L 12 00010000-    >Content-Length: 253 
 9:16:28.431 1 L 12 00010000-    > 
 9:16:28.431 1 L 12 00010000-    >v=0 
 9:16:28.431 1 L 12 00010000-    >o=SIPcontrol 7472200 7472200 IN IP4 192.168.0.106 
 9:16:28.431 1 L 12 00010000-    >s=- 
 9:16:28.431 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:28.431 1 L 12 00010000-    >t=0 0 
 9:16:28.431 1 L 12 00010000-    >m=audio 30060 RTP/AVP 8 0 101 13 
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 9:16:28.431 1 L 12 00010000-    >a=rtpmap:8 PCMA/8000 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:0 PCMU/8000 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:101 telephone-event/8000 
 9:16:28.431 1 L 12 00010000-    >a=fmtp:101 0-15 
 9:16:28.431 1 L 12 00010000-    >a=rtpmap:13 CN/8000 
 9:16:28.431 1 L 12 00010000-    >a=sendrecv 
 9:16:28.431 1 L 12 00010000-SIPX end 
… 

<Below is RX SIP message> 
 
9:16:28.431 1 L 12 00010000-SIPR begin (331 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.431 1 L 12 00010000-    >SIP/2.0 100 Trying 
 9:16:28.431 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.431 1 L 12 00010000-    >TO: "Default"<sip:+17166395101@bufocs.local;user=phone> 
 9:16:28.431 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.431 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.431 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.431 1 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.431 1 L 12 00010000-    > 
 9:16:28.431 1 L 12 00010000-SIPR end 
… 
9:16:28.665 0 L 12 00010000-SIPR begin (408 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.665 0 L 12 00010000-    >SIP/2.0 183 Session Progress 
 9:16:28.665 0 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.665 0 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:28.665 0 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.665 0 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.665 0 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.665 0 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.665 0 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:28.665 0 L 12 00010000-    > 
 9:16:28.665 0 L 12 00010000-SIPR end 
… 
9:16:28.869 1 L 12 00010000-SIPR begin (399 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:28.869 1 L 12 00010000-    >SIP/2.0 180 Ringing 
 9:16:28.869 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:28.869 1 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
 9:16:28.869 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:28.869 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:28.869 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:28.869 1 L 12 00010000-    >CONTENT-LENGTH: 0 
 9:16:28.869 1 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:28.869 1 L 12 00010000-    > 
 9:16:28.869 1 L 12 00010000-SIPR end 
… 
9:16:30.197 1 L 12 00010000-SIPR begin (836 byte) from IP:192.168.0.106 PORT:5060 on socket 3 port 5060 
TCP 
 9:16:30.197 1 L 12 00010000-    >SIP/2.0 200 OK 
 9:16:30.197 1 L 12 00010000-    >FROM: "Dialogic Diva 
SIPcontrol"<sip:+17166392401@192.168.0.106;user=phone>;tag=sipcontrol_2617534104-7668808 
 9:16:30.197 1 L 12 00010000-    >TO: 
Default<sip:+17166395101@bufocs.local;user=phone>;epid=CE4C602FA5;tag=3f5ea65423 
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 9:16:30.197 1 L 12 00010000-    >CSEQ: 1 INVITE 
 9:16:30.197 1 L 12 00010000-    >CALL-ID: 9c046698-730448-17@dmg4000 
 9:16:30.197 1 L 12 00010000-    >VIA: SIP/2.0/TCP 192.168.0.106:9803;branch=z9hG4bK2617534104-7603272 
 9:16:30.197 1 L 12 00010000-    >CONTACT: 
<sip:dmg4000.BufOCS.local:5060;transport=Tcp;maddr=192.168.0.106> 
 9:16:30.197 1 L 12 00010000-    >CONTENT-LENGTH: 253 
 9:16:30.197 1 L 12 00010000-    >SUPPORTED: 100rel 
 9:16:30.197 1 L 12 00010000-    >CONTENT-TYPE: application/sdp; charset=utf-8 
 9:16:30.197 1 L 12 00010000-    >ALLOW: UPDATE 
 9:16:30.197 1 L 12 00010000-    >SERVER: RTCC/3.0.0.0 MediationServer 
 9:16:30.197 1 L 12 00010000-    >ALLOW: Ack, Cancel, Bye,Invite 
 9:16:30.197 1 L 12 00010000-    > 
 9:16:30.197 1 L 12 00010000-    >v=0 
 9:16:30.197 1 L 12 00010000-    >o=- 0 0 IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >s=session 
 9:16:30.197 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >b=CT:1000 
 9:16:30.197 1 L 12 00010000-    >t=0 0 
 9:16:30.197 1 L 12 00010000-    >m=audio 62438 RTP/AVP 8 101 
 9:16:30.197 1 L 12 00010000-    >c=IN IP4 192.168.0.106 
 9:16:30.197 1 L 12 00010000-    >a=rtcp:62439 
 9:16:30.197 1 L 12 00010000-    >a=label:Audio 
 9:16:30.197 1 L 12 00010000-    >a=rtpmap:8 PCMA/8000 
 9:16:30.197 1 L 12 00010000-    >a=rtpmap:101 telephone-event/8000 
 9:16:30.197 1 L 12 00010000-    >a=fmtp:101 0-16 
 9:16:30.197 1 L 12 00010000-    >a=ptime:20 
 9:16:30.197 1 L 12 00010000-SIPR end 
… 

<Bellow is TX Q.931 ISDN message, after SIP session is established> 
 
9:16:30.212 C  3 21:2391:136 - SIG-X(005) 08 02 80 17 07 
                     Q.931  CR8017 CONN 
 
 
 
 


